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Welcome to TinyCAD!

TinyCAD is an open source schematic capture program. Use TinyCAD to draw your own circuit diagrams. 

You can lay out circuit diagrams using the supplied libraries. Alternatively, there is a component library editor 
built into TinyCAD – so you can easily create your own symbols. You may also find more libraries on the 
Yahoo group that other users have drawn for you.

Once you have drawn your design, you can use the special functions to automatically add symbol references, 
check your design against rules of  correctness and create a parts list. TinyCAD can also export a net lists for 
import into PCB layout programs.

Once you have your design you can copy and paste it into other packages such as Word (or better still 
OpenOffice). You may also print your design to any supported Windows printer. If  your design is larger than a 
single page then it can be either scaled to fit on a single page or printed across many pages.

You can get the latest news, release and source code from the SourceForge site. Go to 
http://tinycad.sourceforge.net.  The TinyCAD SVN source code and web site repository is located at 
https://tinycad.svn.sourceforge.net/svnroot/tinycad.  If  you are unfamiliar with SVN, you may find 
TortoiseSVN (www.tortoisesvn.net) to be a good place to start.
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Overview of TinyCAD Features
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2   C H A P T E R  2

2 Drawing a design

Designs are created from built-in objects such as wires, junctions, etc., and from imported component symbols, 
such as diodes, transistors, etc.

To place symbols in to your design

1. Use the Symbol picker on the left of  the screen to browse and select the symbols that you need for your 
design.

2. If  you don't know the name of  the symbol you want then you can use the search facility on the dialogue. 
Enter a word describing the component. As you do so the list of  components will be reduced to include just 
those that contain the text in either their name or description. If  the symbol isn’t present, then you will have to 
create a new one – this is described in the section on libraries.

3. Place the symbols on the design, by selecting them as the current tool. Do this by either double clicking on 
the name, selecting the “Get” button on the symbol picker or click on the preview of  the symbol.

4. You place the symbol by clicking the location of  where you wish to place the symbol. You can rotate the 
symbol by using the tool dialogue that normally sits at the top right of  the drawing area. Select “Up”, “Down”, 
“Left” or “Right” to orientate the symbol.

5. Once you have finished placing symbols of  that type, right click with the mouse to end.

Tip - You can move a symbol’s text fields around. First select the symbol for editing, and then you can drag 
any of  the symbol’s fields with the mouse to a new position on the drawing.

At any one time a certain number of  symbol libraries are in use. The libraries to be searched are listed in the 
libraries option of  the Library Menu. Before you can start using symbols at least one symbol library must be 
listed here. (See the Library Menu, in the menu reference for more help on adding a library to this list).

To wire up your design

1. Use the wire tool, which is the blue line on the toolbar.

2. Move the mouse over the start point of  your wire, a small red circle will highlight any active points on a 
symbol or another wire that it is suitable to start wiring from.
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To wire up your design

3. Every time you click with the left mouse button you will place a corner in your wire.

4. Continue drawing the wire. To end, select another active point (which is shown with the red circle).

5. Notice how the wire tool is magnetic towards symbols’ pins and other wires.

6. When you place a wire connecting to another wire a junction is placed for you automatically.

Tip - It is a common mistake to use polygon lines instead of  wires to wire up components. This should 
be avoided because TinyCAD will not be able to use the special features for you. Wires automatically snap 
to symbols, and without wires you cannot export your circuit to a PCB design program.
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Editing your drawing

Editing your drawing

Once a symbol has been placed you may want to 
change its properties. The edit tool in the drawing 
toolbar is use for editing already placed objects. 
Normally you don’t have to select the edit tool as it is 
the default tool after you have finished with a different 
tool. To select it manually click on the white mouse 
arrow toolbar button.

Whilst drawing an object you may wish to move to 
another area of  the design, so that you can move the 
object to a part of  the design not currently shown. Do 
this by dragging with the middle mouse button 
(normally the scroll-wheel) to pan the drawing, or use 
the scroll-bars. You can also use the scroll-wheel to 
zoom in and out on your drawing.

Use the edit tool in the normal Windows' way – click 
on objects to select them, or select multiple objects using the Ctrl-key or dragging out an area. If  you have just 
one item selected then its options dialogue will be shown to let you change the options of  that object.

You can move objects in the normal Windows' way, which is to select the objects and then drag them. By 
default the connected wires come too, however, if  you wish to unhook a symbol from its wires then drag with 
the Ctrl-key held down.

To delete selected objects use the delete option on the drawing toolbar (a red cross) or use the delete key. The 
normal cut, copy and paste options are also available to you. You can access these from the edit menu or use 
the right-mouse button to bring up the context menu.

If  you prefer you don't have to use the new Windows' editing features of  TinyCAD, still available to you are the 
block move, block drag, and duplicate block tools. These can be found in the block toolbar.

If  you wish to rotate part of  a design (by 90 degrees), then you have to use the block rotate object in the block 
toolbar. Outline the area you wish to rotate and then use the tool buttons to rotate the selected area.

There is a full undo/redo buffer built into TinyCAD. If  you make a mistake you can undo your changes with 
the “Undo” command in the Edit menu.

Whilst you are editing your drawing it is saved automatically for you so you don’t lose any work should 
TinyCAD crash. The default for Autosave is to save your drawing every 10 minutes. The backup drawing is 
saved in the same directory as the original but with an “autosave” extension.
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Symbol attributes

Symbol attributes

Each symbol has at least two text attributes 
associated with it. 

The Name attribute

This is the name or type of  the component that the symbol represents. If  the component has a value then 
insert the value here. For example, if  it were a resistor then the name might be 330R or 4k7. If  the symbol 
represents a phono connector then the name might be Phono.

The Reference attribute

This is an identifier that is unique to the whole design, typical values might be R1 or Q3 etc. There may be 
many resistors each with a Name field of  330R, however, each resistor must have a unique Reference. 
There should only be one symbol with reference R1 in a design.

This field can normally be left as it is, you can use the Special tools to set the references automatically. 
Either use the reference painter to “paint” each reference or use the add symbol references automatically.

The Package attribute

This is the attribute is used for PCB netlist export. The PCB layout program will use this attribute to 
determine which pad layout to use. There is no fixed naming convention for this attribute and it is entirely 
dependent on the footprint libraries supplied with your PCB layout program.

Not all symbols have the package attribute by default. You must add it if  you wish to export to a PCB 
program. To add it, simply click on the “Add” button, and then rename the new attribute to Package.

Other attributes

You may add additional attributes to a symbol from the symbol's tool dialogue. There is no real limit to 
the number of  attributes you add. You may use these references for almost any purpose, for example you 
may wish to add PCB layout instructions here.

All of  the the symbols in the supplied libraries have an “other” attribute already defined for you. However, 
you can add more if  you wish. Either add them by default by editing the symbol in the library or add them 
individually to each symbol at placement time.

Automatic junction placement

Junctions are placed automatically for you, so normally you don't need to use the junction tool.

Where two wires cross they are not considered joined unless a junction is used at the crossing point. 
Junctions are also required when a pin is connected to the middle of  a wire. 

If  you wish to place junctions manually, then switch automatic junction placement off, in the Options  → 
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Automatic junction placement

Settings dialogue, and then the junction tool will be available to you.

When automatic junction placement is on, you cannot select junctions.

Advanced drawing techniques

For the more advanced schematics, TinyCAD has more advanced features.

No Connects

Normally all of  the pins on a symbol must be connected. There may be times when you wish to leave a pin 
unconnected but wish to show that you haven't forgotten the pin and it is intentionally left unconnected.

If  you do not wish to connect to a certain pin then use the no-connect option on the Toolbar. Place a no-
connect on every pin that is not to be connected to anything else. 

Any unconnected pins can be found by using the the Design Rules Checker in the Special menu.

Adding power

Power objects in your design show where power is connected into your 
circuit. Various shapes of  power symbols are defined.

You must always make the connection to power at the end of  the power 
object's pin. A junction may be necessary if  the connection is to the center 
of  a wire or where wires cross. If  a junction is necessary it will be placed 
automatically for you.

The shape of  the power object is ignored - it is the value of  the power 
item which is important. All items connected to power objects of  the same 
value are considered connected together.

Some component symbols, such as the 74 TTL library symbols, are 
automatically connected to power. To ensure the power is correctly 

connected, always use the same power names that are used in the library. For example, when using the 74 TTL 
library use the power names GND and VCC for 0v and 5v respectively.
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Using labels

Using labels

You may use the rotate left or 
right or flip shortcut keys while 
placing labels.

All wires with the same label name 
will be considered connected 
together. This way a connection 
between the wires is formed 
without you having to actually 
draw it.

Use labels to connect wires 
between sheets in the same files or 
to connect wires that are not fully 
drawn as connected on the same 
page due to schematic crowding 

or personal preference.
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Adding buses

Adding buses

Buses can be used to indicate a large number of  connections. To help you draw a bus the repeat options are 
present.

To create a bus, first draw the bus near where you wish to connect it. Now add a bus entry to the bus. Press 'R' 
(for repeat in the Edit Menu) to repeat this as necessary for the number of  entries you wish to make.

Draw a wire from the bus entry to the connection point. Now press 'R' again, to complete all the wire 
connections.

Finally you must add the labels. Place the first label. Depending on your repeat options the label name will be 
updated automatically. Place a label over each wire.

Now the bus connection is complete!

Use the same names for the bus entries on all connections to bus; however, the order of  the names is 
unimportant. Buses do not require junctions anywhere on them.

Once a bus is in place, you may name the bus using the Bus Name tool. You may use this to place some text 
next to the bus. The name can indicate how many conductors the bus represents, by specifying just a single 
number, or it may qualify what the bus is for example by calling it "Data Bus" etc.
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Adding text and annotations

Adding text and annotations

You may add the following annotations: text, lines, rectangles, ellipses and arcs. All these objects will be 
ignored by the special tools.

Annotations may cross wires, symbols and junctions without affecting them. How these objects are used is 
completely up to you.

Drawing rectangles and ellipses

Rectangles and ellipses can be filled and TinyCAD now uses the Windows' default color selection dialogue 
which gives you access to all of  the colors.

To draw a rectangle or ellipse, select the correct tool in the annotation toolbar, and then drag the outline 
of  the shape with the left mouse button. When you release the mouse button the shape will be selected, 
ready for repositioning if  required.

The shapes can be edited by selecting them, by clicking on them and then using the handles to move and 
resize the shape.

You may also select the styles of  the lines and the fill color by using the tool dialogue, normally displayed 
in the top right hand corner of  the drawing.

Drawing polygons & polylines

A polyline is a set of  connected lines, all of  which have to be the same width and color. A polygon is a 
closed set of  connected lines, which is filled.
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Drawing polygons & polylines

To draw either a polygon or polyline first select the tool in the annotation toolbar. Then draw the shape by 
clicking with the left mouse button to place each corner of  the shape. When you have finished place the last 
corner by either double-clicking or by using the right-click context menu.

When finished, the shape will be selected ready for editing. You may select a fill for the shape and select the line 
style using the tool dialogue normally displayed in the top right hand corner of  the drawing. When filling an 
open polyline, an additional line will be added, from the end point to the start point, closing the loop and 
creating a closed set of  lines, a polygon.

You may add arc'ed segments to the outline of  the shape by either using the tool dialogue, or by using the right-
click context menu.

Editing Polygons and Polylines

Once placed the polygon or polyline can:

· Be resized as a complete shape

· have any of  the corners moved

· have a new corner added

· have a corner deleted

· have a side changed from straight to arc'ed

Resize and move the polygon or polyline using the handles displayed once the shape is selected.

To add a corner, right click on the location you wish to add the corner and select new handle from the menu.

To remove a corner, right click on the handle of  the corner you wish to remove and select delete handle.

To change a line from straight to arc'ed or back again, right click on the line you wish to change and select one 
of  the arc options from the menu.

Changing the drawing order

If  one of  your annotations is obscured by another then right-click on it and use the “Z-Order” menu to bring it 
the top of  the drawing order or send it back behind all other annotations.
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3   C H A P T E R  3

3 An introduction to libraries

Symbols form a very important part of  laying out designs. Symbols are collected together in symbol libraries. 
You may edit and create your own new symbols and libraries.

It is unlikely that the symbol libraries provided could possibly cover all the symbols you might ever want. This 
program has been designed to allow you to create your own symbols very easily.

Selecting libraries

Before any symbols can be used from a library, the library must be selected as in use. This is done by using the 
Libraries option in the Library menu.

This dialogue displays a list of  libraries in use. Before a library can be edited or before a symbol can be 
extracted from a library it must be listed here. Once the library is listed then you can extract symbols from it 
using the Get option on the Toolbar. 

To add a library to this list click on the Add button. A file selection dialogue will appear. Select a library index 
file (with a .idx file extension) or database file (with .mdb extension). The selected library will be added to the 
list.

To remove a library from the list, click on the library in the list to select it and then click on the Remove button. 
This does not, in any way, delete the file and library is still available to others. To actually delete the library you 
must use Windows Explorer.
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An introduction to libraries

Libraries that do not exist can also be listed here. If  the library does not exist, then you will be informed 
every time the library's index is read. This normally occurs when TinyCAD is first started and re-read 
libraries option in the Library menu is selected.

You can open the thumbnail view of  the library by double clicking on the library name in the list box, or 
by selecting it and then clicking on the edit button.

Upgrading a library converts it from the old format to the new Microsoft Access database format. This 
format creates a slightly larger file, however, it will enable TinyCAD to have more features in the future.

As of  TinyCAD 1.90.00, the “Tidy” option is no longer required for the new library format, and so has 
been removed from this dialogue.

Editing and Printing Libraries

Use the library dialogue to select the library to edit. Once selected you will see a new window with a 
thumbnail view of  the library. If  the library is a brand new library then the window will be blank.

Use the library editing window to:

· See all of  the thumbnails of  the symbols in the library

· Add new symbols to the library

· Delete and rename symbols in the library.

· Edit a symbols names and attributes
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An introduction to libraries

· Move symbols from one library to another

· Export symbols into an XML file

· Import an XML file of  symbols into this library

You can select symbols in the library by clicking on them. Once selected you can use the “Symbol” menu to 
edit or delete the symbol. You may also right-click on thumbnails to bring up a context menu, which is a 
shortcut for going to the symbol menu.

Use the symbol menu or the context menu to add a new symbol to the library.

A shortcut to editing a symbol is to double-click on it.

Editing and adding symbols

Symbols are created from normal objects found on the Toolbar. They may contain any of  these objects except 
other symbols.

If  the symbol does contain any objects with special functions (such as a power item or a wire) then these object 
will be treated as though they were annotation. All their special functions are lost when used in a symbol.

To edit an existing symbol, first select the library you wish to edit in the Libraries option of  the Library menu.

Next select the symbol to edit in the Library thumbnail view by clicking on it. A new symbol editing window 
will open with the symbol in it. The symbol may be edited in the same way that a normal design can be edited, 
with the exception no symbols may be inserted but pins may be added.

When you have finished use the Save option in the File menu or simply close the window. This will enable you 
to save the new symbol back to the library. The dialogue box automatically remembers the details of  the symbol 
selected. If  you enter a different name here then the symbol will be store under the new name, making a copy 
of  the symbol. If  you enter the name of  an existing symbol then it will replace the old symbol in the library.

Symbol pins

Connections to a symbol is via its pins. It is important to correctly select the type of  each pin. This enables the 
Netlist generation and Check Design Rules in the Special menu to operate correctly. The pins also enable the 
part-per-package feature to work correctly.

The design rules determine the type of  each pin and can determine if  you have made a mistake in your design. 
For example it can check that every net has at least one pin of  type “output” connected if  the net also has one 
or more pins of  type “input”. To do this you have to select the correct electrical type of  each pin when you 
create the symbol..

Multiple parts per package

Some semiconductors have multiple parts per package. You can define a different set of  pins per package and 
optionally outlines for each symbol. When you insert the symbol in to your design, you can select which 
package to use from the symbol.

There are two types of  symbols with multiple parts per package these are homogeneous and heterogeneous 
symbols:

1. A homogeneous symbol has the same outline, but different pins for each part in the package.
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Multiple parts per package

2. A heterogeneous symbol has a different outline and different pins for each of  the parts in the package.

Use homogeneous symbols when the parts are interchangeable. Use heterogeneous symbols when the 
different parts represent different aspects of  the symbol and therefore cannot be interchanged.

Before drawing your symbol decide which type it is to be and then use the “Homogeneous” or 
“Heterogeneous” option in the Library menu or right click on the tabs at the bottom of  the view. These 
options will only work before you have set the number of  parts per package. 
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Multiple parts per package

Then use the “Set part per package” option in the Library menu or right click on the tabs at the bottom of  the 
view. This option will enable to select the number of  parts per package for the symbol. Use the tabs at the 
bottom of  the symbol to select between editing the different parts.

For a homogeneous symbol, any edits to the outline will be for all parts. For a heterogeneous symbol you may 
have a different outline for each part.

An example of  the 7402 IC which has 4 parts per package

For example, the 7402 has 4 parts per package. These parts are label A, B, C and D. This is a homogeneous 
symbol and so the only difference between each part is the pin numbers.
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Creating a new symbol library

Creating a new symbol library

Creating a new library is easy. Use the “New” button on the library editing dialogue. A blank library will be 
created with the name that you specify.

Double click on the library to edit it. You may now add your first new symbol.

Symbol Properties

This dialogue is used to edit the symbol's names and default attributes. As of  version 2.00.00 of  TinyCAD 
you can now give the symbol more than one name. Associated with each name of  the symbol can be as 
many different default attributes as required. There is no restriction on the symbol name, you may use 
upper or lower case and the name may include spaces.

You can access this dialogue in two ways. Either right click on the symbol in the thumbnail view and select 
“Symbol Properties”, or it is displayed after you edit a symbol when you close or save the window.

If  you wish the symbol to have more than one name in the library then use the “Add name” option. Each 
name has it's own set of  default attributes and description. You can use additional names to give different 
attributes to the same basic symbol. For example you may wish to have a different name for a capacitor 
for each of  the different PCB packages (footprint) that you use in your PCB program.
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Creating a new symbol library

You can also add any number of  extra parameters to the symbol. Use the “Add” and “Delete” buttons to add 
new parameters to the symbol. You cannot delete the name or the reference, as these are always required by a 
symbol.

You must enter the default reference for the symbol.. This is the text that appears in the reference field of  the 
symbol when it is first extracted from the library using the Get command. Remember that the reference should 
normally be a single letter followed by a ?. For example: U?

These extra parameters can be used to store any information you like. For example, PCB layout information or 
SPICE information. This information is show to the user when the symbol is placed into the design. The 
parameters are also written out in the netlist (see the Special menu).

Click the OK button to store the symbol, or the Cancel button to exit without changing the symbol.
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4   C H A P T E R  4

4 Printing a design

Once your design is drawn it can be printed to any Windows-supported printer.

The printing options available are outlined in the Print option in the File Menu, detailed in the Menu Reference 
guide.

If  the design will not reasonably fit on a single page then it can be 'tiled' across many pages. That is, each page 
will contain a different section of  the design. Once all the pages have been printed, the pages can be stuck 
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Printing a design

together to form the whole design.

You may also select for the design to fit to a single page. If  you select this option, then the scaling is 
automatically selected for you that will ensure your design will fit on one piece of  paper.

For the best results when drawing a small design, use the Printer Setup option in the Page Setup dialogue. 
This will ensure the design's dimensions will have the same dimensions as the printer's output, making 
scaling unnecessary.

Use the print in black and white option for best results when using a black and white printer.
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5   C H A P T E R  5

5 Exporting to PCB programs

TinyCAD has the ability to create a netlist for import into a PCB layout program. However, for this to work to 
it's best potential you have to use TinyCAD in the correct way:

1. Use wires and symbols correctly

2. Add the “Package” attribute to symbols

3. Export the netlist in a format compatible with your PCB layout program

Use wires and symbols correctly

For TinyCAD to understand the circuit diagram, you must use the “wires” tool to wire up your circuits. If  you 
were to use the polygon lines, then TinyCAD does not know this is a connection and will not export the 
connection to the netlist. To check that your circuit is wired correctly use the “Check Design Rules” option in 
the Special menu, before exporting the PCB netlist.

You must connect a wire to a symbol pin at the tip of  the pin. This is normally done automatically for you. As 
you move a wire close to the symbol a red-circle is show indicating that the wire will be connected to an active 
point on the symbol. If  you do not connect at this point, the wire will not be recognized as connected in the 
PCB netlist export.

Add the “package” attribute to all symbols

When the netlist is exported this attribute is written out with the netlist so that the PCB program will know 
which footprint to use with the symbol. Remember the footprint can often be different for the same symbol in 
different places. For example a capacitor symbol in one part of  your circuit may have a different footprint to a 
capacitor in a different part of  the circuit. 
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Add the “package” attribute to all symbols

You can edit the symbol libraries so that each symbol has a default “Package” attribute.

The example design “amp.dsn” has the “Package” attribute for each of  the symbols that are used. 

Export the netlist in a format compatible with your PCB layout program

From the Special menu select the “Create netlist for PCB program” option.

Use this dialogue to select the netlist output type and the filename you wish to use for the export. 
Currently TinyCAD has a limited select of  file formats, however, you may well find that this format is 
recognized by your PCB program.

All of  the output file formats are text based, so if  you wish to see the result of  the export, try loading the 
exported file into notepad or another text editor.
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6 Using multiple sheet schematics

There are two ways that you can spread a complex schematic over more than one sheet in TinyCAD:

1. You may use multiple sheets (much like Excel sheets)

2. You may use hierarchical drawings (that is insert one file into another drawing)

The two different techniques can be used in the same drawings.

Using multiple sheets

To add another sheet to a drawing, you need only right-click on the “Sheet 1” sheet selection layout at the 
bottom of  the screen and select “Insert Sheet”. This will create a new blank sheet in the same drawing for you.

All of  the sheets in the same drawing must have the same page size, however, each one may have it’s own 
design details. When the design is saved all of  the sheets are saved in to the same file. This is the simplest way 
to create multiple sheet schematics and is very effective for smaller circuit diagrams.

When a netlist is generated for a PCB program the sheets are linked together. Any labels with the same names 
are considered connected between the sheets. Use the labels to make connections across sheets.

You may of  course, remove and rename sheets by right clicking on the sheet name at the bottom of  the screen. 
If  you delete a sheet this cannot be undone, so do so with care!

Using hierarchical designs

You can use the Hierarchical drawing system to embed one design into another sheet. The embedded sheet has 
a symbol associated with it, much like a part from a library.

First you must add a symbol to the file you wish to embed, by using the “Special->Add Hierarchical Symbol” 
menu option. This will add a new special sheet to your drawing. In this special sheet draw the symbol for the 
design. If  you wish to make connections from the parent design to this design, you must place pins on the 
symbol. These pins are almost identical to library symbol pins except they may not have pin numbers, just pin 
names.

To link between the pins on the symbol and the schematic on the other sheets, use labels. Any labels with the 
same names as the pins will be considered connected to the pins when the netlist is generated.
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Using hierarchical designs

Once you have your hierarchical symbol added to your design, you may embed it into other drawings. Do 
this by selecting the “Special->Insert Another design as a Symbol” menu option. This will allow you to 
select a previously saved drawing that has a symbol associated with it. 

The embedded drawing acts much like a library symbol and can be placed, rotated have connections made 
to it. The difference is that when the netlist is generated from the top-level design the lower designs will be 
included and linked using the pins.

Using both hierarchical designs and multiple 
sheets

There are no special requirements for using both techniques for really complex designs. You may have 
many sheets in each of  the files, and include as many drawings as you need to create your design.
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7 Using SPICE with TinyCAD

TinyCAD now has built-in SPICE file generation system. Currently there are no libraries supplied with 
TinyCAD for use with SPICE, you will have to create your own.

You must understand the SPICE file format in order to understand how to use TinyCAD with SPICE. There 
are many good explanations of  SPICE on the web, and if  you are interested in electrical simulation I suggest 
you start with one of  the many free SPICE engines, and hand-craft a few SPICE files before trying to create 
your own SPICE libraries in TinyCAD.

Tip - Remember there is always help!

The creation of  SPICE simulation circuits is not trivial, but it should be straightforward if  you already know 
something about SPICE. If  you get stuck, then use the TinyCAD web-site to get some support.

The TinyCAD SPICE system

TinyCAD generates SPICE files by using a string template system. A SPICE enabled symbol has 3 parts to it:

1. The “model” template – this is the string that is inserted into the SPICE file for every instance of  the 
component in the circuit. 

2. The “prolog” template – this is the string that is inserted into the top of  the SPICE file. It is only 
inserted once per component type. 

3. The “epilog” template – this is the string that is inserted into bottom of  the SPICE file. It is only 
inserted once per component type. 

These three templates can be found on the new “SPICE” tab that is on the symbol properties. Right click on 
the symbol in the library thumbnail view and select “Symbol Properties”.

The SPICE circuit diagram itself  requires 3 parts:

1. The circuit must be constructed using only SPICE enabled symbols 

2. The circuit must have a special “RUN” symbol (which will need to be created by you). 

3. The circuit must have a special “0” node, which is a requirement of  a SPICE circuit. 

Once all of  these requirements have been met, you can use the new option in the "Special" menu to generate 
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The TinyCAD SPICE system

the SPICE file.

34 TinyCAD user manual version 2.80.06 · September 2013



The SPICE template strings

The SPICE template strings

This is written into the output spice file whenever this symbol appears in the net. This line is a template string 
of  what should be written.

For example, for the resistor we would have:

R$(refnum) %(1) %(2) $(NAME)

This means output this line into the SPICE file, however, substitute %() with the net for those pins and 
substitute $() with attributes with those names. For example if  the resistor was connecting nets 7 and 9 together 
and has a name of  10K then TinyCAD would output:

R3 7 9 10K

Notice how each of  the $() and %() parts of  the line have been replaced by the net information.

NOTE: The observant will spot there is a subtlety in the way it generated the “refnum”. This is the symbols 
reference, which would normally be something like “R3”, however, we have included the “R” in the template. 
What has happened is that the “refnum” template string is treated specially; the preceding reference character 
(in this case the “R”) has been stripped. This is so that the spice model character is always an “R”. If  the 
resistor had a reference of  “Q3”, then TinyCAD would still output “R3”, enforcing the correct SPICE model. 
If  the reference where “MyRef ”, then TinyCAD would output “RMyRef ”.

The Spice Prologue and Epilogue

The SPICE Prologues and Epilogues for each symbol have identical syntax to the model template strings, 
except that you cannot use the pin numbers (the %() syntax) and may only use the attribute expansions (the $() 
syntax).

Prologues and epilogues will only be included if  they are not identical to any other, so you can include the 
symbol multiple times in your design but only get one prologue and one epilogue for each one.

You can set the order in which the prologues and epilogues are included in the file by using the priorities. These 
are the numbers at the side the template strings in the Symbol properties dialogue.

For the prologue, anything with a priority of  zero will be put into the file first, and then everything with a 
priority of  1 and so on up to 9.

For the epilogue, anything with a priority of  zero will be put into the file last, and just before it anything with a 
priority of  1 and so on up to 9.

The default priority for the prologue and epilogues is 5 (i.e. the middle).
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The SPICE RUN node

The SPICE RUN node

Normally a spice file contains not only the circuit but also commands to tell the SPICE simulator what to 
do with it.

You can insert these special commands at the head and end of  a file by using a special SPICE symbol 
called the “Run” node. As no SPICE symbols are included with TinyCAD you will have to create the Run 
node yourself.

The RUN node is a normal TinyCAD symbol, except it has no pins and has no SPICE model. It does 
have a SPICE prologue and epilogue template.

You must set a priority of  0 for both the prologue and epilogue. This means its prologue will always go 
first (assuming no other run nodes) and its epilogue will always go last.

This special symbol will then expand into your run-time parameters and place the correct epilogue for the 
SPICE file. 

If  you want to add your special line at the head of  the file, simply add it to the run node's prologue - 
remember it will expand any $(attributes) you put in.

You must place one RUN node on every SPICE simulation circuit, and this will add the correct SPICE 
lines to for the SPICE engine.

In your library you may have more than one type of  Run node, each one instructing SPICE to perform 
slightly different operations, however, you should not place more than one Run node on each circuit.

The “0” net

Every SPICE circuit requires a “0” node. This is the ground for the circuit. You must make sure one of  
your connections is nominated as the ground.

This is done in TinyCAD by using the facility to name net. You can do this in one of  two ways:

1. Use a label. Any connections with a label will use the label’s name in the SPICE net 

2. Use a power symbol (which look like ~ on the toolbar). Any connections with a power 
connection will use it’s value as the name of  the SPICE net. 

So to create the special “0” net, simply place a power symbol with a value of  0 on the ground connection.

Generation of the SPICE file

Once you have met all of  the requirements for SPICE file generation, it is a simple matter to create the 
SPICE output. Go to the “Special” menu and select the “Create SPICE file” option.

There are no options in the SPICE file creation dialogue, because you should use the special “Run” node 
to for this purpose. This gives you maximum flexibility for the SPICE file generation.
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Advanced SPICE file generation with conditional 
statements

For really sophisticated uses of  TinyCAD’s SPICE engine, you may use conditional statements in your 
templates. There are three basic types of  conditional statement, these are:

1. Test to see if  an attribute is defined on the symbol 

2. Test to see if  an attribute is an empty string on the symbol 

3. Test to see if  a pin of  the symbol is connected 

For each conditional statement, you may specify a “true string” and a “false string”. If  the condition is true then 
the macro will evaluate to the “true string”, and the entire macro will be replaced by the “true string”, otherwise 
the entire macro will be replaced by the “false string”.

You can embed one conditional macro statement inside another one, there is no special syntax required for this.

The syntax for the conditional statements is:

?( defined( attributename ), true string, false string ) 

?( not_defined( attributename ), true string, false string ) 

?( empty( attributename ), true string, false string )

?( not_empty( attributename ), true string, false string )

?( connected( pinnumber ), true string, false string )

?( not_connected( pinnumber ), true string, false string )

If  you wish to place a question mark ( “?” ) into your template, then you can escape it by placing the a “\” in 
front of  it.
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8 Menu reference

File menu

New

This gets rid of  the current design. All drawings in the current design are removed. If  the current design has 
not been saved then you are asked to confirm before the design is lost.

Open

This option opens a previously saved design for editing or printing. If  there is already a design being edited it 
will be lost. If  the current design has not been saved then you will be asked to confirm before continuing.

Close

Close the current window. This option will prompt you save any changes if  you have made any.

Save

This option saves the current design, its page set up and the design details are all saved in a single file. If  the 
design has already a file name associated with it then it will be saved using this file name without prompting. If  
the design has never been saved then you will be prompted for a new file name before it is saved.

Save As

This option is similar to the Save menu option; however, you will always be prompted for a file name. Using this 
option you can save the current design using a new file name or place it into a different directory.
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File menu

Design Details

Each design has details 
of  its full title, the 
author, etc. This option 
allows you to change 
these details. When the 
design is next saved, 
these details are saved 
with the design.

If  the Display Details 
box is checked then 
these details will be 
displayed and printed in 
the bottom right hand 
corner of  your design.

Import

Using this option you can place into the current design another previously saved or exported design.

When selected you will be prompted to enter the file name of  a saved design. This design will be loaded 
and displayed. You can move the positioning of  the imported design with the mouse. Place the design 
using the left mouse button or cancel the operation using the right mouse button.

Save as bitmap

Using this option you can save a copy of  the design as a PNG file for sharing with people who do not 
have TinyCAD installed on their computers. If  you have an area of  the design selected then just that area 
will be saved into the PNG file. If  nothing is selected on the design then the entire design, including the 
design details and design rulers will be written into the bitmap.

Print

Use this option print to any installed the windows printer. 

If  the drawing is larger than the paper size of  the printer, then it is split up over as many pages as it takes 
to print the design in tiles. 

Print Preview

This option is to show you how the design would be printed on your printer. You can use this option to 
see if  it will be printed the way you want before you actually print on paper.

Page Setup

This option allows you to select the 
total size of  the design.

Some commonly used values are 
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given. If  you prefer you can enter your own size in millimeters of  the page. Selecting Portrait will ensure the 
design is taller than it is wide; selecting Landscape will ensure the design is wider than it is tall.

The printer setup option is used with the printer setup button. Click on the printer setup button and select the 
printer and the type of  paper you will use. Now when you return to the Set Page Size dialogue the width and 
height of  the design will be set to match exactly the printable area of  the printer.

The page size is saved with the current design when it is saved. The last page size entered here will be 
remembered for the next new design you start.

Exit

This option will exit the program and remove it from memory.
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Edit menu

Undo

This option undoes the last action or sequence of  actions performed on the design. For example, you can 
Undo the last drawing operation or undo the last deletion.

You may select this option repeatedly. This will cause the design to return to even more distant versions.

The opposite of  this option is Redo.

Redo

This option is the opposite of  the Undo option. If  you select Undo then the last operation of  the design 
will be undone. If  you then change you mind about the Undo, selecting Redo will reverse the action of  
Undo.

Repeat

If  the last object placed in the design was repeatable, this option creates another copy of  it in a new 
location (depending on the repeat direction).

Only wires, line, dashed lines, buses and bus entries can be repeated.

They are repeated above, below, to the left of, or to the right of, the last placed object. This can be selected 
by the Up, Down, Left, Right option in the repeat directions menu.

Cut

This option enables you to move parts of  the design which have been selected to the clipboard. Once it 
has been moved to the clipboard you may use paste to re-insert them into a different part of  the design, 
and may paste again and again to duplicate a part of  the design.

To select objects in the design use the edit item option on the toolbar.

You may also paste into other Windows applications such as Microsoft Word.

Paste

This option takes a previously copied or cut part of  a design and enable you to place it into the current 
design.

Once this option has been selected the pasted design will be displayed at the mouse pointer. To paste it in 
click with the left mouse button, to cancel click with the right mouse button.
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Copy

This option enables you to copy parts of  the design which have been selected to the clipboard. Once it has 
been copied to the clipboard you may use paste to re-insert them into a different part of  the design, and may 
paste again and again to duplicate a part of  the design.

To select objects in the design use the edit item option on the toolbar.

You may also paste into other Windows applications such as Microsoft Word.
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Copy to...

Using this option you can save just part of  the current design. This part can be loaded as a design in its 
own right, or imported into another design.

Only the current selection will be written into the output file. A dialogue box will prompt you 
to enter the file name to save the export design. Remember, this dialogue can be moved out of  the way to 
see which parts of  the design have been selected.

Find

This options can be used to find specific uses of  text in the design. The user enters the text to be found. 
This text is then searched for in the design. Each occurrence of  the string is has a marker placed on it and 
all the occurrences are placed in the design marker dialog.

The markers are removed from the design when the dialog box is close. Clicking on the text in the dialog 
box moves the associated marker to the center of  the design window.

Tag

This option prompts you to name the selected area, and adds the tag to the design. When the tag is re-
selected using the Tags option, this same area of  the design is displayed in the design window.

Set Tag

This option prompts you to name the selected area, and adds the tag to the design. When the tag is re-
selected using the Tags option, this same area of  the design is displayed in the design window.

By naming different parts of  the design, a large design can still be navigated using these tags.

Zoom In

Increase the size of  the drawing to show more detail. You can also zoom in using the mouse scroll-wheel 
or by using the zoom tool from the drawing toolbar.

Zoom Out

Increase the size of  the drawing to show more of  the drawing. You can also zoom out using the mouse 
scroll-wheel or by using the zoom tool from the drawing toolbar.
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Library menu

Libraries

This option brings up the dialogue box which allows the setting up and editing of  libraries.

The list in the dialogue box is a list of  libraries searched when the Get option (in the Library menu) is used. 
You may add or remove these libraries from this list using the buttons at the side of  the list.

The Add button in the dialogue allows a library not currently being searched to entered into the search list. 
When this option is selected a file selection dialogue appears. Select the index file (those files with .idx 
extensions), which belongs to the library you wish to use. The library is then added to the list box.

The Remove button removes a library from the search list. It does not delete it! Select the library you wish to 
remove by clicking on it in the list box, then click on the remove button.

The Edit button allows you to:
- View & Print thumbnails of  the symbols
- Add new symbols to this library
- Edit existing symbols in the library

The Tidy button causes a library to be tidied up. Select a library to tidy by clicking on it in the list, then click on 
the Tidy button. When the library has been tidied a message box will appear informing you of  this.

Libraries will need tidying after they have been extensively edited. Tidying the library will make it smaller by 
removing the unwanted old (now deleted) symbols in the library.

Refresh symbols from libraries

Normally symbols are saved with the design, so any changes to the libraries do not effect your design straight 
away.

This option causes all the libraries currently in use to be re-read, and any changes displayed in the current 
design. This only effects the design in the current window.
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Part in Package

This option can only be used when you are editing a library symbol.

When a symbol has more than one part per package, this option allows you to edit each part individually.

Each part in the package must have the same symbol outline, but with different pins. Therefore this 
option only effects the pins in the symbol.

When you select a new part per package, which has not yet been defined, you will be given the option to 
copy over the pins in the current part into the new part. Select Yes, if  you wish to have the pins in the 
same layout for each part in the package. This is highly recommended. Once the pins have been copied, 
you can edit their pin numbers using the Edit Item option in the Edit menu.

Add Pin

This option can only be selected when you are editing a library symbol.

Pins are used to show where the connections to each symbol are.

Pins of  various shapes are provided, however, these shapes are for cosmetic purposes only. They do not 
effect how each pin is considered to be connected.

There are various types of  pin. These type govern how the electrical rules checker operates. The electrical 
rules checker checks which pins of  what type are connected together and determines whether or not this 
will produce a correct circuit.

All pins must have a pin number. If  the device is not one that has pins numbers (such a capacitor), then 
what the numbers are is arbitrary - but they must all be different. Pin numbers can also include letters. 
This is so the pins of  a Pin Grid Array device can be correctly labeled.

Pins can optionally have a name. This is not necessary however.

The pin number and name can be shown or hidden. To hide the text click on the check box next to the 
text in the dialogue box.

Pins of  type power are special. Although they are shown when editing a symbol, when the symbol is 
placed in a design these pins are hidden. Once the symbol is placed in a design pins are automatically 
connected to the power of  the same value as their name. Therefore these pins must have a name. This can 
be used in conjunction with the parts per package option to allow the placing of, for example, logic gates, 
without need to show the power connection explicitly. A power pin cannot be connected to normally, all 
connections to this pin will be done automatically.

A pin of  type hidden will be shown when editing a symbol, as with power pins, and hidden when the 
symbol is placed into a design. However, the normal connections are expected to be made to this pin, even 
though it is unseen. The symbol design must indicate where these pins are to allow easy connection.

Each pin is associated with a part per package. A single symbol may have more than one part per package. 
For example a 7400, consists of  4 NAND gates. Each part has different pin numbers on each pin. To 
select which part per package the pin you are placing belongs to use the Part in Package option in the 
Library menu.

To place a pin click with the left mouse button in the design window. When a pin has been placed, the pin 
number in the dialogue box will automatically be advanced for you.

Placing can be canceled by clicking with the right mouse button.

Once a pin is placed the pin number is either incremented or decremented, automatically for you. The Pin 
Increment/Pin Decrement options in the repeat directions menu (in the Edit menu) select which way the 
pin number is changed.
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Also if  the pin name has a number at then end of  it then it too is also incremented or decremented. The Name 
Increment/Name Decrement options in the repeat directions menu (in the Edit menu) select which way the pin 
name is changed.

Pins can be edited. To edit them select the Edit Item option in the Edit menu, then click on the end of  the pin 
(the same end as you placed, and would connect a wire to).

Pins can also be moved or deleted.

Symbol menu

Tip - This menu is only visible when you are viewing symbol thumbnails in a library editing window.

New symbol

Add a new symbol to this library. A symbol editing window will open and you can start designing your symbol 
in it. Use the “file save” menu option to save the new symbol back to the library.

You can use any of  the drawing tools to create your new symbol. The circuit drawing items lose their special 
significance in a symbol and all of  the drawn objects are treated as annotations. For example, if  you place a wire 
in the symbol then it is not treated as a wire in when the symbol is placed into a design. The only drawing 
objects that have any significance in a symbol are pins.

Use the “Add Pin” option in the library menu to place a pin into a symbol.

The new symbol will not appear in the library until the symbol has been saved.

Edit Symbol

Select a symbol thumbnail in the library edit window and then use this option to edit it. The symbol is loaded 
into a symbol edit window so that you may alter it. See the “New Symbol” option for more information about 
editing symbols.

You can also use this option to copy symbols. Edit the symbol and then save it under a different name.

Rename symbol

Select a symbol thumbnail in the library edit window and then use this option to rename it. If  you wish to make 
a copy of  the symbol under a different name use the “Edit Symbol”.

Delete

Select a symbol thumbnail in the library edit window and then use this option to delete it. Once it has been 
delete it is not immediately possible to undo the change, however, you have the option not to save the changes 
when you close the library editing window.
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Special menu

Create Net List for PCB Programs

A net list is a file which contains a list of  all the connections made in a circuit diagram. All objects which 
are connected together are in a single list, called a net. For symbols each objects pin is considered a 
different object. Each net is given a different name.

Net lists are useful for programs such a PCB layout tools which can check you layout to see if  it matches 
the layout of  the circuit diagram, or even suggest a PCB layout from the net list. These more advanced 
features will be better supported by this program in future releases.

As of  version 1.95.15, there are multiple netlist formats supported. The original TinyCAD format is still 
there, along with PADS-PCB, Protel and Eagle SCR output format.

PCB programs require the footprint to be specified. Do this by adding an attribute to the symbol that has 
a name “Package”, and the value is the value name of  the footprint in the PCB program.

Check Design Rules

This option will cause the current design to be checked against a list of  rules it must obey.

The rules test for gross errors in the design. For example, they will tell you if  two outputs are connected 
together. They do not tell you if  the design will work or not. However, if  the design has errors in it picked 
up by this tool, then it is properly incorrectly drawn.

Once selected a dialogue box will appear. Each rule that is checked can be turned on or off  before the test 
is done in this dialogue box.

Once the OK is selected the design is checked. Any errors are circled by a red ring. A list of  errors is 
displayed at the side of  the design. Clicking on any item in the list will cause that error to be moved to the 
center of  the design window.

Selecting Edit Item in the Edit menu, then clicking on an error will cause it to be highlighted and also 
cause the error name in the error list to be highlighted.

If  the Done button in the list is selected all the errors will be removed from the design.

If  no errors are found then a list will appear stating so. This list can be removed by selecting the Done 
button.

Error circles can edited, moved or deleted. Error circles will not be saved with the design.

Generate Symbol References

This option changes the symbol references in your design. It relieves you of  the task of  ensuring each 
symbol has its own unique reference.

One this option has been selected a dialogue box will allow several options to be changed. You can either 
add or remove the current references. Removing references can be useful if  you wish to integrate this 
design into another.

You can apply the changes to all references, that is the entire design will have potentially all of  it references 
changed. Use this option if  you do have not yet built the design, or have not issued any copies of  the 
design to others.
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You can apply the changes to only un-numbered references. This will ensure only new symbols with references 
with a ? in them will be changed. Use this option if  you are modifying an existing design, and wish to leave 
existing components with their original references.

You can apply the changes to only references matching a give reference. This will apply to all references 
matching the one entered, even if  the symbol has already been assigned a reference. Use this option, for 
example, to renumber all the capacitors without renumbering any other symbol.

If  you wish you can allow this tool to determine what the correct symbol reference for the symbols is. 
Alternatively you can enter your own.

When you select the OK button the options will be applied to the design. Each symbol specified will be given a 
new reference. If  you select remove references then each symbol will have its references changed back to one 
with a ? instead of  a value.

You may select Cancel to not apply the reference generator.

Create Parts List

This option creates a list of  all the parts used in the design. This list is sorted by symbol reference, and all parts 
of  the same type are listed together.

Essentially this is a list of  parts that need to be purchased to make the design.

The parts list is store in a simple text file, which can be edited and printed using notepad.

Tidy Design

This option improves the way the design is stored without effecting the way it looks.

In this release it does this by removing unseen object from the design.

This includes:

- Wires, buses, arcs and lines with zero length.

- Labels and text with no text in them.

- Rectangles and ellipses with no area.

This option removes errors than can creep in during editing which are difficult to remove yourself  because they 
are unseen.
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Options menu

Settings

Show Grid

This causes the grid to be displayed. If  the grid is too fine to show at the current zoom then it will not be 
displayed. To see the grid zoom in. If  the fine grid is enabled then the points which lie on the normal grid 
as well are shown as crosses.

Snap to Grid

This option should under normal conditions be selected. This option makes any mouse position snap to 
the nearest point on a grid. This allows the easy alignment of  objects. It also ensures when you attempt to 
connect a wire to a symbol that the connection is made correctly. For this reason snap to grid should 
always be on.

If  the snap to grid feature is turned off  then when you attempt to connect a wire to a symbol it is very 
difficult to ensure both the end of  the wire and symbols connection point are on the same point. With 
snap to grid this is made easy. If  they are not on the same point, not only does it look untidy when printed 
but it will also be considered unconnected by the special tools.

Normal, Fine, User grid spacing

In most cases you will wish to use normal grid spacing. A fine grid has twice as many points to a normal 
grid and is especially useful for annotating a design and drawing symbols.  If  you wish you may specify 
your own grid spacing by entering the spacing in the dialog box. You may enter the units in inches or mm, 
depending on the Units setting (as described below).

Units in mm or units in inches

This defines which units are used by the whole program inches or mm. The ruler and show position dialog 
will reflect the changes.
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Scroll bar increments

This determines by how much the design will be scrolled when the arrows at the side of  each scroll bar is 
clicked.

Colors

This option will cause a dialogue box to be displayed with the current colors in use by the current design. If  you 
wish to change any of  the colors for the objects shown, simply click on the color and then select a new one. 
This will change the color for that object in the entire design. Currently you may change the colors of: wires, 
junctions, no-connects, buses, pins and power elements.

If  you wish to return the colors to the TinyCAD default, select the “defaults” button in the dialogue.

Show Position

This option will cause a dialogue box to be displayed with the current co-ordinates of  the mouse pointer in the 
design.

The position is displayed in either inches or mm depending which units are selected by the Grid Settings option 
in the Options menu.

To remove the dialogue box select this option again.

Snap to Grid

Turn the snap to grid on or off. This is a short-cut for the same option in the Grid Settings dialogue.

Repeat Directions

This option is a sub-menu with options for the repeat command, and options for use when placing labels, text 
and placing pins.

The Up, Down, Left, Right options specify where an object is placed when it is repeated.

The Name Increment/Name Decrement options specify how label names, text or pin names are altered after 
they are placed.

The Pin Increment/Pin Decrement options specify how the pin numbers are altered after placing a pin. Note 
that you can only place pins when editing a library symbol.
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9 Toolbar reference

Annotation toolbar

Arc segment

The only arcs which can be drawn are the arcs which represent one quarter of  an ellipse. Arcs are for 
annotating your designs only, they are ignored by all the special tools.

Arc segments are now part of  the polyline tool. See the section on “Adding Text and Annotations” for full 
details.

To draw an arc select the starting point with the left mouse button. Then move or drag to the ending point and 
click again with the left mouse button. If  the arc bows the wrong way, then draw the arc in the other direction 
or select the other arc type (either arc in or arc out) from the toolbar menu or context menu. 

You may change the width of  the line the arc is drawn with or the color of  the fill of  the arc by using the tool 
dialogue normally displayed in the top right hand corner of  the drawing.

Arcs can be edited as part of  a polygon or polyline.

Ellipse

Ellipses are only used to annotate designs. They are ignored by all the Special tools.

The only ellipses that can be drawn are those which can be enclosed by a rectangle with its edges parallel to the 
edges of  the design.

To draw an ellipse you must start by moving to one corner of  the rectangle that will enclose the ellipse (this 
rectangle is not actually displayed). Click with the left mouse button. Now as you move or drag the mouse the 
ellipse will be shown. Once the ellipse is in the correct position click again with the left mouse button.

You may change the width of  the line the arc is drawn with or the color of  the fill of  the arc by using the tool 
dialogue normally displayed in the top right hand corner of  the drawing.
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Polyline and polygons

Polylines and polygons are provided to annotate your diagrams only. For the most part, they are ignored 
by all the special tools.

These tools are new to TinyCAD version 1.80.00, and are described fully in the “Adding Text and 
Annotations” section.

Rectangle

Rectangles are only used to annotate designs. They are ignored by all the Special tools.

To draw rectangles, select the tool on the Toolbar. Then go to the position for one of  the corners of  the 
rectangle. Click with the left mouse button. Now as you move or drag the mouse the rectangle will be 
shown. Once the Rectangle is in the correct position click again with the left mouse button. You may 
change the width of  the line the arc is drawn with or the color of  the fill of  the arc by using the tool 
dialogue normally displayed in the top right hand corner of  the drawing.

Text

Text is used only to annotate designs, it is ignored by the special tools.  Do not confuse the text tool with 
the label tool, which produces electrically active net names.

It is often required to have bars over the letters in the text. This can be done by placing the ` character 
before each letter that needs a bar over it. If  a whole word needs to have a bar placed over it then each 
letter in that word must have a ` before it.

Type the text you wish to add in the dialogue box. As you enter text a rectangle will appear next to the 
mouse, indicating the size and position of  the text.

Move this rectangle with the mouse to where you wish to place it and click with the left hand button.

You can cancel entering text by clicking with the right mouse button.

Text can be edited once placed. To do so select Edit Item on the Toolbar. Then click with the left mouse 
button on the text to be edited. A window will appear with the original text in it. You can now alter it as 
necessary. When finished either click with the left mouse button on something else to edit, or click with 
the right mouse button.

Text can be re-sized once placed by using the handles displayed around the item or by using the tool 
dialogue normally displayed in the top right hand corner of  the drawing.

Drawing toolbar

Bus

Click with the left mouse button in the place you wish to start the line. Move to where you wish the line to 
end and click with the left hand button again. A bus segment will be placed and a new bus segment is now 
started from this point.

To stop drawing click with the right mouse button, and you may start a new bus from a different point. 
Clicking with the right mouse button again will select the Edit Item option in the edit menu.
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Normally the bus is locked to 90 degree positions. In this mode two line segments are displayed at once. 
However, only one segment is placed at a time when you click with the left mouse button. You must click once 
more to place both the bus segments.

You may also lock to 45 degree angles only, or have no locking at all. This can be selected from the edit window. 
When these options are used, only one bus segment at a time is displayed.

If  you find when you try and place two bus segments in rapid succession and find that only one is placed, then 
the cause is properly due to the double click speed of  the mouse being setup so that it is too slow. Go to the 
Control Panel and alter the double click speed faster. (See the Window's Manuals for more details).

Buses cannot be edited, but they can be moved, dragged or deleted.

Buses can be repeated.

Bus Entry

Bus entries are used to show the connection of  a wire to a bus. There are two types of  bus entry, allowing for 
connection into the bus from any possible direction.

To place bus entries, select this option in the menu, then move the bus entry to the point you wish to place it. 
Place it by clicking with the left mouse button.

When you have finished placing, either select a new tool or click with the right mouse button. This will select 
the Edit Item in the Edit menu for you.

Bus Entries cannot be edited, but they can be moved or deleted.

Bus Entries can be repeated.

Bus Name

A Bus Name placed across a Bus to indicate the nature of  the Bus. This could be the number of  conductors in 
the bus or the name of  the Bus.

It is often required to have bars over the letters in a Bus Name. This can be done by placing the ` character 
before each letter that needs a bar over it. If  a whole word needs to have a bar placed over it then each letter in 
that word must have a ` before it.

Type the name of  the bus in the dialogue box. As you enter text a rectangle will appear next to the mouse, 
indicating the size and position of  the text.

Move this rectangle with the mouse to where you wish to place it and click with the left hand button.

You can cancel entering text by clicking with the right mouse button.

Bus Names can be edited once placed. To do so select Edit Item on the Toolbar. Then click with the left mouse 
button on the text to be edited. A window will appear with the original text in it. You can now alter it as 
necessary. When finished either click with the left mouse button on something else to edit, or click with the 
right mouse button.
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Block toolbar 

Move Block

This option allows you to move parts of  the design around. The connections by wires are not preserved 
when this option is used. If  you wish to keep the connections use the drag block option.

Select the area you wish to move by drawing a rectangle around it. Start the rectangle by clicking with the 
left mouse button. Click again with the left mouse button again when the rectangle covers the area you 
wish to move.

The area selected will be highlighted. You can now move this area around the design. Place it by using the 
left mouse button.

You can cancel the move by clicking with the right mouse button.

Drag Block

This option allows you to move parts of  the design, keeping the connections made by wires. All wires and 
buses that pass into the selected area to be moved will keep their ends outside the selected area fixed in 
place. All connections to symbols by wires will also be preserved.

This allows for objects to be moved around the design without affecting how they are connected.

Select the area you wish to drag by drawing a rectangle around it. Start the rectangle by clicking with the 
left mouse button. Click again with the left mouse button again when the rectangle covers the area you 
wish to drag.

The area selected will be highlighted. You can now drag this area around the design. Place it by using the 
left mouse button.

You can cancel the drag by clicking with the right mouse button.

Duplicate Block

This option allows you to make another copy of  part of  the design to be placed somewhere else in the 
design.

Select the area you wish to duplicate by drawing a rectangle around it. Start the rectangle by clicking with 
the left mouse button. Click again with the left mouse button again when the rectangle covers the area you 
wish to copy.

The area selected will be highlighted. When you move the mouse you will find that the original copy 
remains and you have a duplicate copy that can be placed anywhere in the design. Place this copy by using 
the left mouse button.

You can cancel the duplication by clicking with the right mouse button.

Rotate Block

This option allows you to rotate and mirror (flip) a selected area of  the design. This makes it very easy to 
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correct the mistake of  placing a component the wrong way round, as it and all its connections can be rotated.

Select the area you wish to rotate by drawing a rectangle around it. Start the rectangle by clicking with the left 
mouse button. Click again with the left mouse button again when the rectangle covers the area you wish to 
delete.

The area selected will be highlighted.

A dialogue box will now give you options to rotate the block clockwise or anti-clockwise, by clicking on the 
<<< and >>> buttons. You can also select the flip button which will mirror the block.

Once you have finished rotating the block click with either the left hand or right mouse button.
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Drawing toolbar

Delete Item

This option allow you to delete objects in the design.

To delete an item first select the Edit Item tool. Select the item to delete by clicking on it with the left 
mouse button. The object will turn gray to indicate it has been selected. You may instead of  selecting a 
single item with the edit tool select a group of  items. These too may be deleted.

Now select this option on the toolbar menu to delete the item.

You may undo the deletion by using the undo option in the edit menu. 

Edit Item

This option enables editing of  objects already placed in the design. You may also use this tool to move 
objects in your design and to delete objects in your design.

Once this option has been selected then clicking with the left mouse button on an object in the design will 
select that object. To show it has been selected it will be shown in light gray.

If  there is more than one editable object under the mouse pointer, then clicking again with the left mouse 
button in the same place will cause a different object to be selected. Keep clicking with the left mouse 
button until the object you wish to edit is selected.

If  the object is editable, then a dialogue box associated with the object will be shown enabling you to 
change it. For example, if  you click on a text object then a dialogue box will appear with the text in it. You 
may then change the text in the dialogue box.

End editing an object by clicking with the right mouse button in the design window, or by selecting a new 
object to edit using the left mouse button.

You may also move objects that are selected. To do this hold down the left mouse button on a selected 
object. Now move the mouse, with the left mouse button held down. The object will be moved with the 
mouse. To finish release the left mouse button.

You may delete any selected object by using the delete item option on the toolbar.

You may copy any selected object to the clipboard by selecting the Copy or Cut options in the edit menu. 
Once a selection has been copied to the clipboard it may be pasted into another application (such as 
Microsoft Word), or pasted back into the design.

To select groups of  objects you may drag a rectangle around the objects to be selected. Any object within 
the rectangle will be selected. Once it has been selected you may delete, move, copy or cut the object. To 
drag the rectangle, place the pointer in an area of  the design where there is no object. Hold down the left 
mouse button and move the mouse. The rectangle will be created. Release the left mouse button to select 
the objects within the rectangle.

Junction

Junctions are normally automatically placed for you. You do not need to use this tool.
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When two wires meet, a junction indicates that they are electrically joined. This information is used by the 
special tools to generate net lists and check the electrical rules. When two wires meet or cross it is assumed they 
are not joined unless a junction is placed at the crossing point.

To place a junction select this option, then move the junction to the location in the design where you wish to 
place it and then click with the left mouse button. When you have finished placing, either select a new tool or 
click with the right mouse button. This will select the Edit Item in the Edit menu for you.

Junctions cannot be edited, but they can be moved or deleted.

Label

Labels indicate a connection to the wire which runs beneath them. Any two wires with the same label name 
above them are considered to be connected.

This can be useful when two parts of  a circuit need to be connected but are a long way apart on the diagram, or 
one point needs to be connected to a large number of  others.

It is often required to have bars over the letters in the label. This can be done by placing the ` character before 
each letter that needs a bar over it. If  a whole word needs to have a bar placed over it then each letter in that 
word must have a ` before it.

Type the text you wish to add in the dialogue box. As you enter text a rectangle will appear next to the mouse, 
indicating the size and position of  the text.

Move this rectangle with the mouse to where you wish to place it and click with the left hand button.

After placing a label, if  the text has a number on the end of  it, it is automatically incremented or decremented 
depending on the Name Increment or Name Decrement option selected in the Repeat Directions menu (in the 
Edit menu).

You can cancel entering text by clicking with the right mouse button.

Labels can be edited once placed. To do so select Edit Item on the Toolbar. Then click with the left mouse 
button on the text to be edited. A window will appear with the original text in it. You can now alter it as 
necessary. When finished either click with the left mouse button on something else to edit, or click with the 
right mouse button.

Labels can be re-sized once placed by using the handles displayed around the item or by using the tool dialogue 
normally displayed in the top right hand corner of  the drawing.

No Connect

No connects indicate that the symbol, wire or power item is not connected to anything else, and should not be 
connected to anything else. The electrical rules checker will indicate an error if  an input is unconnected unless it 
has a no connect joined to it. Place no connects on any unused input or output to avoid this error and indicate 
that it is intentionally left unconnected.

To place a no connect select this option, then move the cross to the location in the design you where wish to 
place it and then click with the left mouse button. When you have finished placing, either select a new tool or 
click with the right mouse button. This will select the Edit Item in the Edit menu for you.

No connects cannot be edited, but they can be moved or deleted.

Power

Power objects are use to show where power is connected to the design. All power objects should have a value, 
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which is the value of  the power it provides (such as 5V, GND, 0V etc.). All power objects with the same 
value are considered connected to one another; even if  they have different shapes.

You should connect wires to the power items at the end of  their pins, otherwise they will not considered 
to be connected.

Certain symbols are automatically connected to power without the connection being shown (for example 
the 7400, although no power pins are shown, it is automatically connected to VCC and GND). When 
using these symbols, you should make sure you use the same power supply names as the symbols 
otherwise the symbol will not be correctly connected to the power supply.

To place power items in to your designs select power from the Toolbar. Then in the dialogue box select 
the orientation of  the power item, it's shape and it's name. Place the power item by clicking with the left 
mouse button.

A range of  shapes is provided, and you may use any name. Bars may be added over letters in names in the 
same manner bars can be added to text and labels, that is by placing ` before each letter which requires a 
bar over it.

Once you have finished placing power items click with the right mouse button or select a new tool.

Power items can be edited. To do so select Edit Item in the Edit menu. Click with the left mouse button 
on the end of  the power item's pin. You can now change it's name, orientation and shape. When finished 
either click with the left mouse button on something else to edit, or click with the right mouse button.

Power items can also be move and deleted.

Wire

Wires are used to indicated connections on the circuit diagram. If  you wish to use features such as the 
electrical rules checker or net list generation then you must use wires for this purpose. If  you use lines 
instead of  wires to join up points on a diagram then these tools will not work!

Click with the left mouse button in the place you wish to start the wire. Move to where you wish the wire 
to end and click with the left hand button again. A wire segment will be placed and a new wire segment is 
now started from this point.

If  you prefer you can drag wires instead of  using the clicking and then moving. Simply drag with the left 
mouse button from the starting point to the ending point. If  the ending point is a symbol, another wire or 
a power item then the wire will automatically snap to it and terminate at that point.

A wire will automatically snap to a placed symbol or another wire when moved close to it. If  you click 
with the left mouse button now, the wire will end at the snapped point. You can turn this off  by using the 
settings dialogue in the Options menu.

When placing wires junctions will automatically be added when required.

To stop drawing click with the right mouse button, and you may start a new wire from a different point. 
Clicking with the right mouse button again will select the Edit Item option in the edit menu.

Normally the wire is locked to 90 degree positions. In this mode two line segments are displayed at once. 
However, only one segment is placed at a time when you click with the left mouse button. You must click 
once more to place both the bus segments.

You may also lock to 45 degree angles only, or have no locking at all. This can be selected from the edit 
window. When these options are used, only one wire segment at a time is displayed.

If  you find when you try and place two wire segments in rapid succession and find that only one is placed, 
then the cause is properly due to the double click speed of  the mouse being setup so that it is too slow. 
Go to the Control Panel and alter the double click speed faster. (See the Window's Manuals for more 
details).
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Wires cannot be edited, but they can be moved, dragged or deleted.

Wires can be repeated.

Zoom

The zoom tool enables you to easily enlarge the view of  the design. Once selected you may enlarge the view by 
clicking with the left mouse button, and reduce the view by clicking with the right mouse button.

The position of  the mouse pointer, when you zoom in, is moved to the center of  the window.

Tip - You may also use the scroll-wheel to zoom.
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File toolbar

New

This gets rid of  the current design. All drawings in the current design are removed. If  the current design 
has not been saved then you are asked to confirm before the design is lost.

Open

This option opens a previously saved design for editing or printing. If  there is already a design being 
edited it will be lost. If  the current design has not been saved then you will be asked to confirm before 
continuing.

Save

This option saves the current design, its page set up and the design details are all saved in a single file. If  
the design has already a file name associated with it then it will be saved using this file name without 
prompting. If  the design has never been saved then you will be prompted for a new file name before it is 
saved.

Cut

This option enables you to move parts of  the design which have been selected to the clipboard. Once it 
has been moved to the clipboard you may use paste to re-insert them into a different part of  the design, 
and may paste again and again to duplicate a part of  the design.

To select objects in the design use the edit item option on the toolbar.

You may also paste into other Windows applications such as Microsoft Word.

Paste

This option takes a previously copied or cut part of  a design and enable you to place it into the current 
design.

Once this option has been selected the pasted design will be displayed at the mouse pointer. To paste it in 
click with the left mouse button, to cancel click with the right mouse button.

Copy

This option enables you to copy parts of  the design which have been selected to the clipboard. Once it 
has been copied to the clipboard you may use paste to re-insert them into a different part of  the design, 
and may paste again and again to duplicate a part of  the design.

To select objects in the design use the edit item option on the toolbar.

You may also paste into other Windows applications such as Microsoft Word.
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Print

Use this option print to any installed the windows printer. 

If  the drawing is larger than the paper size of  the printer, then it is split up over as many pages as it takes to 
print the design in tiles. 
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10 Change log

Changes since version 2.80.02

• New Feature #3043277 - Show '*' in title bar when document has been changed.

• New Feature #3062572 - Auto DRC before netlist generation.

• New Feature #3001869 - Add DRC check for unplaced multiple gates This DRC check is active when the 
"Unconnected nets" option is selected. In the ERC list it is reported as: "Not all parts in this package are in 
this design".

• New Feature #3121004 - Single key Rotate and Duplicate - When a symbol or group of  objects is selected, it 
is now possible to Rotate, Flip and Duplicate with a single keystroke.  The recognized keys are: R, L, F and U 
for Right,Left,Flip and Duplicate respectively.

• New Feature #3121047 - Keep symbol options dialog open - When TinyCAD looses focus, it now keeps the 
tool dialog open.  This allows convenient switching between applications without having to reselect the object 
again.

• New Feature #3121306 - Spreadsheet compatible BOM - New 'speadsheet compatible CSV' file type in the 
"Create Parts List" function.

• New Feature #3089316 - 'symbol origin' marker.  The symbol origin is used as an anchor when changing the 
part number, showing power pins and when replacing the symbol.

• New Feature #2998184 - Value parameter in PADS-PCB Netlist.

• Bug Fix #3097650 - library symbol picker: the filtering made case-insensitive.

• Bug Fix #3089308 - Prevent writing '1.#QNAN' into the dsn file at node 
TinyCAD/SYMBOLDEF/FIELD/POS.  This anomaly was caused by the solution for "hidden power pins 
bug".

• Bug Fix #3067069 - Improvement to the DEL key functionality. Allow all common 
cut/copy/paste/delete/undo/redo keyboard shortcuts to be usable in a dialog.

• Bug Fix #3103931 - Symbol parameter fields too small in the symbol property dialogs.

• Bug Fix #3112030 - Attribute edit box stays visible - When editing an attribute on the "Update library 
symbol" dialog, and then switch to the 'SPICE' tab, the attribute edit box stays visible.
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• Bug Fix #3089316 - Improved symbol 'anchor' handling when the symbol has no explicit origin marker.

• Bug Fix #3109743 - Improved "not" bar position for labels.

• Bug Fix #3125062 - Dr Watson crash on generate XML netlist.

• Bug Fix #3105141 - Crash after DRC correction and recheck.

• Bug Fix #3087569 - No prompt to "save changes" after editing "Design Details".

• Bug Fix #3106824 - Can't undo network wire color change.

• Bug Fix #3046032 - refdes default Visibility follows Name setting.

• Bug Fix #2710265 - Ampersand in filenames gets turned into _ in the title (design details) block.

• Bug Fix - Improved ruler markings readability.

• Bug Fix - Incorrect grid display near 0,0 position.

• Bug Fix - Reference generator didn't use all parts of  a symbol.

• Bug Fix - The symbol's  'NAME type' and 'REF type' where always read from file as '0'.

• Bug Fix - Scaled+mirrored symbols with pins did not snap to the correct pin's hot-spot position.

• Bug Fix - Replacing a symbol did not correctly refresh the display.

• Bug Fix - Copying to and from an Hierarchical Symbol sheet gives error: "This file was not created by 
TinyCAD".

• Bug Fix - Ampersand gets turned into _ on all symbol property dialogs.

• Bug Fix - Ampersand gets turned into _ on sheet name tab.

• Bug Fix - Refresh display problem of  top symbol in library symbol edit list when scrolling up.

Changes since version 2.80.01

• Bug Fix #3092340  - 5-step crash using Text Tool - Yet another fix for the 'DEL' key problem. In this 
case it is the ESC key with the focus on a modal dialog.

• Bug Fix #3089308 - Hidden power pins will connect to other hidden power pins in different symbols if  
the symbols are arranged such that the hidden power pins active ends are positioned on top of  each 
other.

• Bug Fix #3094447 - ERC list does not show up

• Bug Fix #3096965 - Duplicate parts after Paste+Undo - After pasting (Ctrl+V) a selection, and then do 
Undo (Ctrl+Z) you will end up with a duplication of  your initial selection, which is difficult to detect.

• New Feature Request #3097756 - Add Ctrl+A to select all objects

• FAQ List updated with Q&A #4.

66 TinyCAD user manual version 2.80.06 · September 2013



Changes since version 2.80.00

Changes since version 2.80.00

• Bug Fix #3085720 - Fixed problems involving the No-Connect pin or the No-Connect net markers failing to 
warn if  they are connected to output pins or to each other.

• Bug Fix #3085512 - Additional fixes to the DEL key problem

• New Feature:  Some of  the more important choices in the annotation dialog choices are now stored in the 
Windows Registry.

• Bug Fix #3086798 - Hierarchical designs not compatible between 2.80 and 2.70.  Hierarchical designs from 
older versions of  TinyCAD will now work in newer versions of  TinyCAD.

• Bug Fix 3089306 - Temporary fix for problem with hidden power pins connecting with net lines based on 
X/Y coordinate match.  This does not solve the problem of  symbols with hidden pins connecting with 
hidden pins from other symbols because this temporary solution simply moves the pins away from the 
drawing area by a fixed amount.  Hidden pins that were on top of  each other prior to the translations will still 
be on top of  each other after the translation.  They simply won't connect with any visible net lines.

• Bug fix 3089316 - Annotating multi-gate parts changes symbol origin.

• Bug Fix 3088063 - Auto-incrementing a pin number from 99 to 100 crashes.

• Bug Fix #3089312 - Various annotation commands don't participate in undo/redo.

• Bug Fix #3067069 - Incomplete deleting of  text and label.

• Bug Fix #2903136 - DEL key not working.

• New Feature:  Symbol picker now sorts the symbols before displaying them.

• New Feature:  Added the FAQ list to the Help file.

• New Feature:  Added the LGPL Version 2.1 license text to the license file for easy reference.

• Bug Fix #2548253 - Disable the "No Connect" button when editing symbols

◦ Changes since version 2.70.03

• Feature Requests #2722995 implemented.  Message now says that "This file was not created in TinyCAD.".

• Feature Requests #3015178 implemented.  Now all menu items that open a dialog box end with "..." as is 
customary in Windows and other modern GUI's.

• Feature Requests #3015564,2794990,2798597 implemented.  The library panel is now tree based and clearly 
displays the name of  every library and symbol in an outline format.  It is no longer necessary to select 
showing one library at a time or all of  them (flattened).  All libraries are always shown plus a recent selections 
virtual librarary.  Click on the ‘+’ sign in front of  the library name to view and select the contents of  the 
library.

• Bug Fix #xxxxxxx implemented.  Crashes no longer occur when accessing members of  the most frequently 
used library symbol list.  Now if  an entry becomes obsolete, it is removed from the list so that it can't be 
selected.

• Bug Fix #2782974,2633697 implemented.  Corrected the misspelling of  the word "Annotate" across all files.

• Bug Fix #xxxxxxx implemented.  Corrected the misspelling of  the word "Hierarchical" across all files.  As a 
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consequence of  this type fix, new TinyCAD design files that contain hierarchical symbols cannot be read 
by older versions of  TinyCAD, but newer versions of  TinyCAD will still be able to read older design 
files.

• Bug Fix #??????? implemented.  Extended the design rule checker to include tests for non-case distinct 
net names, unassigned reference designators, and nets with multiple names.

• Feature Addition:  The ERC list box now pans the selected ERC marker into the middle of  the currently 
open editing window.  In addition, all ERC messages now list pertinent information about the object in 
question such as reference designator, XY coordinate, pin number, net name, etc.

• Bug Fix #??????? implemented.  ERC markers will now always appear highlighted when selected.  
Previously, if  several ERC markers were present on the same object, only the marker on top would 
highlight, making it very difficult to tell where some ERC markers were located.

• Bug Fix #3058944, 2887870 implemented.  The MSVC runtime library is now installed by the installer.

• Bug Fix #2870991 implemented.  This change fixes the netlist problem that caused it to not generate the 
correct netlist when multiple labels were attached to the same net AND the net extended across multiple 
pages with different names on different pages.

• Bug Fix #2370118 implemented.  This fix removes the limit on the the number of  characters allowed in 
the sum of  all library names from 2048 to the maximum permitted by Windows.  This new number will 
vary depending on the native language selected for use on Windows.  The most common Unicode 
languages use 16 bit wide characters while some Asian languages require 32 bit wide characters.  While 
TinyCAD will still "forget" all of  the library names if  this new limit is exceeded, it is now large enough 
to include more than 100 libraries in the default location in the longest of  Unicode character sets, so this 
problem is effectively behind us.  Technically, Windows XP and newer (Vista, Windows 7) have a length 
limitation for the value of  a registry key limited only by available memory while Windows 98 is lower, 
somewhere around 16K bytes.  For 16 bit wide characters, this means that Windows 98 will limit to 8K 
characters while newer versions are effectively only limited by available memory/2.

• Bug Fix #??????? implemented.  The No-Connect marker is now disabled when editing a symbol.

• Bug Fix #3067069 implemented.  For power objects and labels, the accelerator keys now delete, cut, 
copy , and paste the object right after selecting it.

• Feature Addition:  A "Re-Check" button has been added to the ERC message box to permit rechecking 
the design after changes have been made without having to go through the dialog again.

• Feature Addition:  ERC "not connected" warnings have been eliminated for pins of  type "not-
connected".

Changes since version 2.70.00 Build 248 Beta

New features

• Added .TCLib (SQLite3) format libraries to the installer.

• Added a very large number of  libraries that have been organized and cleaned up by Stephen Friederichs.  
Many of  these new symbols include footprint references suitable for FreePCB.

• Added XML format netlist capability.  This is an advanced method of  identifying the information in a 
parts list and netlist  that makes it easier to write your own custom formatter or use the data in another 
program more easily.

• Added improved pin name and number auto-increment capability to provide better support for alpha-
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numeric pin names and numbers.  Thanks Thomas Peterson!

• Added improved reference designator assignment so that designators are labeled according to the order of  
their XY coordinates.  When auto-assigning reference designators, designators are now assigned to the sorted 
XY coordinates so that symbols located to the upper left of  the schematic are assigned lower numbers than 
symbols located to the lower right of  the schematic.  Thanks Oleg Skydan!

• Added new PDF format user's manual.  Thanks Greg Endler!

• Fixed the long broken help file pictures and re-enabled the text search function.

Changes since version 2.60.01

This release contains an internal upgrade to make TinyCAD compatible with the Visual Studio 
2003/2005/2008 development environment. Previously, it was only compatible with VS2003. The major 
improvements changes to the user interface to improve productivity and a large number of  bug fixes. Here is a 
quick summary of  what has changed in this release:

New features

• Modified the TinyCAD source to support Visual Studio 2003, 2005, or 2008 to be more convenient to 
developers who have newer or older versions of  Visual Studio.

• Improved the readability of  the XML outputs by adding tabs in front of  tags to indicate nesting level and also 
added additional newlines in between tags when nesting in or out. No functional changes, only changes in the 
visual appearance of  any of  the XML output files when opened in a text editor. If  you have reason to edit the 
XML files from time to time, you will find that the open source program Notepad++ available from 
SourceForge.net is an excellent light weight XML editor.

• Extensive changes to macros that opened files and macros that manipulated zero terminated strings to 
convert to the new secure versions (i.e., the ones that now have "_s" appended to them). This change does 
not affect the behavior of  TinyCAD, it only enhances the safety of  the program against buffer overruns.

• Updated dao360.dll to a newer build that includes the version information (necessary for newer version of  
NSIS installer). Note that this is only a newer build, not a new version as this was already the most recent 
version.

• Extensive changes to "for (int i=xxx" type statements to comply with newer ANSI C++ standards that 
changed the scope of  index variables declared within for loops. 

• Changed one iterator style for loop that no longer complied with the newer ANSI C++ standards. 

• Modified code that received warnings due to mixing signed and unsigned variables by adding casts where 
necessary and type changes where appropriate so that no warnings are now produced when compiling with 
warnings level #3.

• Added the complements of  the 3 existing Spice conditional macros so that both the normal and the "not" 
versions are available now.

Bug fixes

• Fixed crash that resulted when you attempt to backspace over the line thickness field when editing a schematic 
line.

• Fixed inconsistent line endings problem with the Spice netlist file and the XML file outputs.
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Known Bugs

All known bugs are tracked at the TinyCAD Bug Tracker on SourceForge.net.

Changes since version 2.50.00

New features

• Homogeneous and Heterogeneous symbol support.

• Show power pins on a symbol.

• New pin shape with the name above instead of  at the end of  the line.

Bug fixes

• Improved handling of  delete so it should crash less!

• Internally switched to a Unicode application for better handling of  international character sets.

• Better placement of  symbols so that they should remain in the same place after saving and reloading.

70 TinyCAD user manual version 2.80.06 · September 2013



11   C H A P T E R  1 1

11 Changes and/or corrections 

This program is open-source and so is all of  the documentation. You can download the source HTML from 
the sourceforge web-site. The source and documentation is stored in a Subversion (SVN) repository.  You can 
use a free program called TortoiseSVN if  you wish to check out a copy of  the source or documentation from 
the repository.  Only registered TinyCAD developers can commit changes to the repository, but you can also 
email your changed files to Don dot Lucas at OrikonSolutions dot com with a short explanation of  your 
changes and Don will integrate your changes into the trunk of  TinyCAD.  You should identify which revision 
of  the repository that you started with, or at least the date that you checked your working copy out so that Don 
can determine what changes you made.  If  you wish to do a translation or wish to correct any errors then please 
do so!

How to build TinyCAD

If  you wish to make changes to your copy of  TinyCAD and then build a new executable image, please read the 
documentation stored in the TinyCAD SVN repository under the directory name “How_To_Build_TinyCAD”. 
Complete descriptions of  the required software tools and build procedure is contained in several documents in 
this directory.
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12 FAQ - Frequently Asked Questions – FAQ

1. Q.  I have created my drawing and tried to create a Net List, but I did not know about Package Attributes.  The manual 
does not explain how to add these attributes to the symbols on the drawing I have made.  It says click ADD, but in what?  
The package attributes would be different for each component you place on the drawing but I can't see how you add these 
attributes.

A.  After the symbol is placed on the schematic select it and a 'xxx Tool Options' window opens.
In this there is a list of  the current parameters and their values.  If  a 'Package' parameter is not present click the 'Add' 
button at the bottom.  This will put a line in which reads 'Other Yes ...' .

Change 'Other' to 'Package' and '...' to the name of  the footprint for that symbol to use in the layout. You also have the 
option whether to display it or not.

The process is similar for library symbols:
In the Library editor you can edit the 'Symbol Properties' to change or insert a package definition.  If  you have the correct 
'Package' definition in the library symbol it will carry over to the schematic automatically. 

The same 'Package' definition may be used for several different symbols and there may also be similar symbols with 
different 'Package' definitions. You have to decide what package you will use for the symbol. Of  course you can change 
your mind at any stage so long as what you end up with works. 

Bear in mind that the TinyCAD pin numbers used must match the pin numbers in the footprint referenced by the 
'Package' parameter. That is how things are connected.

Please read the User's Manual section 'Help/Get more from TinyCAD/Exporting to PCB programs'.

2. Q.  How do I enter a pin name or other text if  I want a bar over the text to signify the NOT function?

A.  For each letter of  the text string that you want to be shown with a bar over it, enter the non-shifted version of  the 
tilda character ('`') before the letter that you want to have an overbar appearance.  This little used character is also known 
as the grave accent, from the Latin word “gravis”, meaning heavy.  By requiring a special character for each overbar 
character, you gain the possibility of  specifying mixed names such as “UP/DOWN”.  For this particular name, you would 
enter “UP/`D`O`W`N”.  This special character, on English language keyboards, is usually located near the upper left hand 
corner of  a full keyboard, underneath the ESC key.  It is also usually on the same key as the tilda character ('~').  On 
European keyboards, it will most likely be in a different location or not present on a key directly at all.  You must use the 
<Alt> numeric keypad method (<Alt> 096).  If  any user wants to email us and let us know where it is located in other 
languages, we will add it to this answer for the convenience of  all of  our users.

3. Q.  When I create a new symbol and I want to save it to my Lib it does not allow me to change the name when I'm 
clicking on add name.  How do I give it the name that I want?

A.  At some point you should see the 'Update Library Symbol' window.  In this window there is a 'Name' parameter. 
(Right hand panel).  If  you change the 'New Symbol' text to be the name of  your new symbol it will get saved in the 
selected library under that name when you click '[Store]'.  You can add a 'Name' parameter with the '[Add]' button but you 
can't use that, it has to be the default one.  
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If  you edit a symbol and change its 'Name' parameter it does not create a copy when you '[Store]' it, just the symbol 
name changes.  

If  you want to add a modified version of  symbol XXX, select the symbol in the library list, <right click> and use 
'Duplicate' to create a 'Copy of  XXX'. Select that and edit the 'Name' parameter text in it.

The 'Add Name' button creates an alias for the current symbol which can then have a different set of  properties but 
the same graphic.  Select the symbol name in the left column to access its properties in the right panel. Both alias 
names will show in the schematic selection list.

4. Q.  I have a medium sized schematic in TinyCAD. Something appears to have gone wrong with it in that there is a 
duplicate of  every symbol directly underneath the original one but has no connections. For example, there is a 
resistor with wires connected, if  you drag it away there is another one with the same references etc. directly 
underneath. This has happened with every symbol on my schematic including labels. If  I select all and try to move or 
delete it does not get rid of  the duplicates as they are selected too. 

How can I get rid of  the duplicate symbols? 

My only method so far is to move each symbol to the side, delete the one underneath and then put the original back. 
As you can imagine, this is going to be time consuming and error prone. 

A.  I did this once by copying all of  the blocks on the page and then while pasting, I accidentally “dropped” the 
block on top of  itself.  Of  course, you can “undo” this by hitting the Ctrl-Z key just as in any other Windows editor 
up until when you panic and hit “save” ;-)  Once saved to disk, it can be fixed, but not so easily.

I recommend that you do this fix only with TinyCAD version 2.80.01 or later as earlier versions will make it a lot 
harder to delete the duplicate symbols.

Step 1:  Working from left to right, top to bottom, you must methodically select and then delete each symbol, each 
net label, each text object, and each power label once (assuming that you accidentally only pasted a single copy of  the 
block).  Don’t worry about net lines as these will get automatically fixed later.  If  you select and then delete a symbol 
and it disappears entirely, then hit Ctrl-Z to undo it as this symbol did not have a duplicate (either you already deleted 
it or it wasn’t part of  the original copy/paste mistake).  Don’t worry about which symbol is connected to the net line 
and which one isn’t – it won’t matter.  Notice carefully that when 2 symbols are on top of  each other, you will get an 
auto-junction connection dot on top of  the active end of  each pin.  Deleting one of  the symbols will not 
automatically make this go away, thus the instruction to work _methodically_ from left to right, top to bottom.  This 
will all get fixed in the next step, but you first have to successfully remove every duplicated object with the exception 
of  the net lines and auto-junction connection dots.  Again, when 2 identical objects are on top of  each other, it 
doesn’t matter which one that you delete.  The way the selection mechanism works, you will always select the top 
object in the Z axis.  This is usually the one that the net lines are routed to, but again, it doesn’t matter.

Step 2:  You now have removed all of  the duplicate symbols, but you still have a mess of  auto-connection dots that 
did not get automatically removed when you deleted the duplicate symbol (this should actually get turned in as a bug 
– the auto-connection dots should be automatically removed when no longer needed, but TinyCAD apparently 
doesn’t do this presently).  Now you have to trick TinyCAD into re-evaluating the auto-junction connection dots.  
This can be done by selecting everything on the page by holding the left mouse button down and dragging the 
selection rectangle until it covers all of  the objects on the page.  Let go of  the mouse button and this will leave all of  
the objects selected.  Now put the cursor over one of  the symbols and again press the left mouse button down, hold 
it, and very carefully drag the selected objects a small amount in any direction.  Notice that the net lines will not all 
drag appropriately – this is because the auto-connect dots are not yet correct and TinyCAD is confused by the 
jumble of  objects.  Very carefully drag the selection so that it is exactly back on top of  itself  and then (and only 
then!) let the mouse button go.  The graphics will appear unchanged at this point.

Step 3:  Move the mouse over some empty spot on the schematic and click the left mouse button once so that the 
selected objects are no longer selected.  As soon as all of  the objects are de-selected, the auto-junction connection 
dots will then be recalculated and will now be fixed graphically and your schematic is now repaired.  If  you still see a 
few auto-junction connection dots on the symbol pin ends that shouldn’t be there, that tells you that you missed 
some of  the duplicate symbols so simply repeat this process until all of  the duplicates have been deleted and the 
auto-junction connection dots have all been recalculated.

Step 4:  You should save your design at this point!
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